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options, paths, File Info, and the type of disk
you have—can add to the size of the file on
disk. On the other hand, if you save in a
compressed format, such as JPEG, this num-
ber may be significantly larger than the file
size on disk.

The number on the right indicates the file’s
approximate size in its layered format includ-
ing alpha channels. This number is usually
greater than the file size on disk because
Photoshop is able to compress certain data,
such as alpha channels, when it saves the file
to disk. The larger the image, the greater the
difference between this number and the saved
file size. Also, if the 2.5 Format Compatibility
option is turned off in the More Preferences
dialog box (it’s on by default), the saved file
size will be significantly smaller with layered
files because the 2.5 compatibility option
saves a flattened version of the file with the
layered file.

Scratch Sizes
The number on the left represents the amount
of memory that is currently being used by the
program to display all open images. This
number also takes into account any informa-
tion on the Clipboard.

Welcome pardners, and gather ‘round
the campfire. Ol’ Russ has got some
tips for you to chew on next time
you’re out there on the Photoshop
Trail. And since we’ve got both Macin-
tosh® and Windows™ hands with us,
we’ll be giving you keyboard shortcuts
like this: Mac key/Windows key.
Saddle up!

The number on the right represents the total
amount of RAM available for processing
images. This number is equal to the amount
of memory available to Photoshop minus
the amount that Photoshop needs to run
(up to 7 MB on a Power Macintosh). When
the number on the left is greater than the
number on the right, Photoshop must use
the virtual memory scratch disk in addition
to RAM. At this point, you’ll probably notice a
dramatic decline in Photoshop’s performance,

The pop-up menu in the lower left of the
window lets you display four sets of infor-
mation related to disk space and memory:
Document Sizes, Scratch Sizes, Efficiency
and Timing. Document Sizes tell you about
the amount of data in the image; Scratch
Sizes tell you about the amount of RAM
used to display the image. Note that the
amount of data in an image and the amount
of RAM used to display the image may be
very different values. Efficiency displays the
percentage of Photoshop operations being
performed using RAM. If Photoshop is
using the scratch disk, the display will be
below 100%. Timing tells you how long the
last operation took.

Document Sizes
The number on the left represents the
printing size of the image—that is, the
amount of data that will be sent to a printer
if you print the file. The printing size is
approximately the size of the saved, flattened
file in Adobe Photoshop format. That’s
because other factors—your preview

Memory required for all open images and Clipboard
Total RAM available to Photoshop

document and scratch sizes

Amount of data including
layers and alpha channels

Amount of data that will
be sent to the printer
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because Photoshop must read and write
files using whatever disk you’ve designated
as your scratch disk in the Swatches Prefer-
ences. Adding more RAM to your system
(and allocating more RAM to Photoshop
on the Macintosh) may help avoid using the
scratch disk in many situations and so keep
Photoshop operating at peak performance.

One additional word of warning though,
regardless of whether or not you’re using
virtual memory, the amount of free space
on your scratch disk must be greater than
or equal to the amount of RAM you have
allocated to Photoshop. To ensure good
performance, Photoshop writes the entire
RAM contents to the scratch disk during idle
times. If the scratch disk runs out of free
space, Photoshop quits taking RAM—
regardless of what you have allocated to the
program. This means that if you’ve allocated
60 MB to Photoshop but you have only
10 MB of free space on your scratch disk,
Photoshop will use only 10 MB of RAM.

Memory and preview options
You can choose from three types of preview
options in the Saving Files Preferences dialog
box. Each of these options builds a preview
image that is updated and saved with the file
each time you save.

Icon: the image that appears on the desktop

Thumbnail: the image that appears in the
Open dialog box

Full Size: a 72-dpi preview of the image that
is displayed in other applications, such as
Adobe PageMaker and QuarkXPress.

Preview options increase the size of the file
on disk, as well as the time it takes to save the
file. If your file takes a long time to save, try
turning off the Thumbnail and Full Size
options (the Full Size option is off by
default).

You may also find that turning off the thumbnails in
the Layers and Channels palettes improves perfor-
mance as you work. If you are experiencing perfor-
mance problems as you work with channels and
layers, try turning off the thumbnails in the Palette
Options dialog boxes.

The movable lens flare
You can create a lens flare
over an image that you
can then move around the
image for different effects.
Simply create the lens flare
on a separate layer filled
with a black background.
Then use the Screen mode
in the Layers palette to
make the black area disappear. You can now use
the move tool to drag the flare around the image.
Use the Opacity slider to fine-tune the results.

Layers palette

Quick Techniques
Layers Palette Options dialog box

Screen mode Opacity

Final imageOriginal image Lens flare on black:
Screen mode



4

i

Rubber stamp tool
Reset the rubber stamp tool to the Clone
(aligned) option by Option/Alt + clicking
anywhere on the image.

Shadows
Make quick painted shadows with any of the
brushes by selecting the Behind mode in the
Paintbrush Options palette. Behind mode
lets you paint only on the transparent parts
of a layer. Select the color and opacity you
want, and start painting.

tool and palette tricks
Color palette modes
Command/Ctrl + click the color bar at
the bottom of the Picker palette to choose
a different color spectrum for the palette.
Shift + click the color bar to cycle through
all of the available options.

Click the minimize box in the upper right
corner to display only the color bar in the
Color palette.

RGB Spectrum

CMYK Spectrum

Grayscale Ramp

Current Colors

Behind painting mode on a
transparent layer; Airbrush,
50% opacity

Compact palettes
Double-click the tab title on any of the palettes
to hide the palette below the tab. Note that
palettes snap to the sides of the monitor as well
as to each other.

Palette positions
Open Preferences > General. Click the option
labeled “Reset Palette Locations to Default.”
This will set your palettes back to their default
positions.

Palette shortcuts
Tab = Hides all palettes

Shift + tab = Hides all palettes except
tool palette

If the tool palette is snapped to the left and
other palettes are snapped to the right side
of the monitor, the image will not grow
under the palettes.

Tool option shortcuts
On the Macintosh, you can press the
Control key while using any of the tools
in the Tool palette and get a context
sensitive menu.
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Arrow keys
Up Arrow and Down Arrow: While you are
editing a number field, these keys bump the
value up and down by one unit. Shift +
Arrow key bumps the value by 10 units.

Use the arrow keys to nudge a selection one
pixel in the direction of the arrow. Press Shift
+ arrow key to move the selection 10 pixels.

With the move tool selected, use the arrow
keys to nudge the target layer one pixel and
Shift + arrow key to move the layer 10 pixels.

Cropping tool
To crop an image to the height, width, and
resolution of another image, first select the
image that has the dimensions and resolu-
tion you want to
copy. Then select
Fixed Target Size,
and click Front
Image in the
Cropping Tool
Options palette.
Now return to the other image and crop.

Opacity, pressure, and exposure
You can change the opacity, pressure, or
exposure of any painting or editing tool
using the number keys. Press 1 to change
the setting to 10%; press 0 to change the
setting to 100%. Use double digits in quick
succession to set percentages like 63%.

With any non-painting or editing tool
selected, press any number key to change
the opacity of the target layer.

Type tool
On the Macintosh, you can force Photoshop
to build a new Font menu (if you have a
utility like Adobe’s ATM Deluxe) without
quitting and restarting Photoshop:

1. Add the fonts you want via the utility, then
quit the utility.

2. Select the type tool.

3. Press the Shift key when you click inside
the image. A message appears that tells you
Photoshop is building the font menu.

Selection tools
While using one of the selection tools, these
key commands will come in handy.

Shift = Add to the selection

Option/Alt = Subtract from the selection

Spacebar = Hand tool

Command/Ctrl + click outside selection +
drag = Move selection with layer

Click inside selection + drag = Move selection
area only (not pixels)

Command/Ctrl + click inside selection +
drag = Cuts and floats selected pixels

Command/Ctrl + Option/Alt + click inside
selection + drag = Floats copy of selection

Command/Ctrl + Shift + I = Inverse selection
Cropping Tool Options palette

Red channel only

Reset All Tools
Use the Reset All Tools command in the
Options palette pop-up menu to return all
tools to their default settings.

Displaying single channels
Command/Ctrl + 1 = Red

Command/Ctrl + 2 = Green

Command/Ctrl + 3 = Blue

Command/Ctrl + 4 = Channel 4

Command/Ctrl + 5 = Channel 5

Command/Ctrl + ~ = Composite

easy channel selections
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Loading channel selections from the
Layers palette
You may never have to use the Load Selec-
tion menu command again. These shortcuts
load any channel, layer mask, or transpar-
ency mask with one keystroke. They’re fast,
they’re easy, they’re fun.

Command/Ctrl + Option/Alt + 1 = Red as
selection

Command/Ctrl + Option/Alt + 2 = Green as
selection

Command/Ctrl + Option/Alt + 3 = Blue as
selection

Command/Ctrl + Option/Alt + 4 =
Channel 4 as selection

Command/Ctrl + Option/Alt + ~ =
Composite as selection

Command/Ctrl + click Layer Mask
thumbnail = Layer mask (on target layer)
as selection

Command/Ctrl + click Layer thumbnail =
Transparency mask (on target layer) as
selection

Loading channel selections from the
Channels palette
Command/Ctrl + click Red = Red selection

Command/Ctrl + click Green = Green
selection

Command/Ctrl + click Blue = Blue selection

Command/Ctrl + click #4 = #4 as selection

Simple channel calculations
You can do some of the most powerful
calculations directly in the Channels and
Layers palettes using the standard Shift and
Command/Ctrl key combinations to add
and subtract. These techniques are shortcuts
to the new options in the Save Selection
dialog box.

To add and subtract existing channel
contents in the active window:

1. Command/Ctrl + click the channel to load
the channel as a selection.

2. Use the following key combinations:

Command/Ctrl + Shift + click additional
channel = Add channel

Command/Ctrl + Option/Alt + click
additional channel = Subtract channel

Command/Ctrl + Option/Alt + Shift + click
additional channel = Select intersection of
selected channels

Command/Alt + click a channel to load
the channel as a selection

Command/Alt + Shift + click an additional
channel to add the channel to the selection

Red channel loaded
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Floating selections on layers
Move any floating selection to a new layer
by dragging Floating Selection layer in the
Layers palette above the destination layer.
Press Command/Ctrl + D to paste the
floating selection.

Dragging layers between documents
Shift + drag a layer to another image or
window with the same dimensions and
resolution, the layer is automatically pin-
registered to the new layer.

Shift + drag a layer between two images with
different dimensions or resolutions, the layer
is centered. If you want to drag grouped
layers to another image or window, you must
drag from the image window. Dragging from
the layers palette will only move selected
layer. Shift + drag a layer to another image or
window with a selection, and the layer is
centered within the selection.

Selecting a layer from the keyboard
Option/Alt + [ = Selects the next visible
layer down the layer stack

Option/Ctrl + ] = Selects the next visible
layer up the layer stack

Shift + Option/Alt + [ = Selects the bottom
layer

Shift + Option/Alt + ] = Selects the top layer

Command + ] = Moves layer up 1

Command + [ = Moves layer down 1

Note: This doesn’t work on Background
layers.

If only one layer is visible, these shortcuts
cycle through the Layers palette, making
layers visible one at a time.

Duplicating channels
The Duplicate Channel command in the
pop-up menu of the Channels palette lets
you copy a channel into a new document
without going through the Clipboard. This
new method of copying channels can save
you both time and RAM.

tips for the layers palette

s

Creating a layer the quick way
Click the New Layer icon at the bottom of
the Layers palette to skip over the New Layer
dialog box when creating a layer. If you want
to change the name of the layer later, double-
click the layer to open the dialog box.

Option/Alt + click the New Layer icon to
bring up the New Layer dialog box when
creating a layer.

Command/Ctrl + click the new Layer icon to
make an adjustment layer.

Option/Alt + double-click a Floating
Selection layer in the Layers palette to
paste the selection onto a new layer with-out
opening the Make Layer dialog box.

Copy and paste layers
If the layer selected is completely empty and
you paste, the image is pasted into the layer.
If the layer has something on it a new layer
is made.

Viewing layers
Option/Alt + click in the eye column next to
a layer to hide all layers but that one. Option/
Alt + click again to redisplay all layers. (You
can also drag through the eye column to
redisplay layers.) The paintbrush icon next
to the eye icon indicates painting on a layer
or layer mask.
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Loading selections
Command/Ctrl + click Layer thumbnail =
Loads layer transparency

Command/Ctrl + click Path thumbnail =
Loads path as selection

Merging layers
Use the Layers palette pop-up menu and the
following keys for more merging power.

Option/Alt + Merge Visible = Merge visible
layers into currently selected layer

Option/Alt + Merge Down = Merge selected
layer down and leaves copy of selected layer

Redefining the Background layer
If you want to move, add a layer mask to,
or adjust layer options for the Background
layer, you first need to redefine the layer as
a non-Background layer. To do this, just
double-click Background in the Layers
palette, and rename the layer. (Click OK
and rename the Background Layer 0.)

Option/Alt + Shift + click layer mask
thumbnail
Displays the layer mask in Quick Mask mode
over the underlying image. Option/Alt Shift +
click again to exit Quick Mask mode.

Option/Alt + click layer mask thumbnail
Displays the temporary layer mask channel
so you can view just the mask as you edit it.
Option/Alt + click again to redisplay the
image.

Command/Ctrl + click layer mask
thumbnail
Loads the layer mask as a selection.

Layer mask vs. image layer
Command/Ctrl + \ = Layer mask selected

Command/Ctrl + ~ = Image layer selected

Moving layer masks and layers
Layer image linked to layer mask + move tool
with no selection = Moves both layer and
layer mask

Layer mask targeted + link off + move tool
with no selection = Moves mask only

Layer image targeted + link off + move tool
with no selection = Moves layer image only

Layer image selected + link on or off + move
tool with selection = Moves and floats only
layer image inside selection

layer mask shortcuts
Creating a layer mask
Click Layer Mask icon = Layer mask filled
with white

Option/Alt + click Layer Mask icon = Layer
mask filled with black

Creating a layer mask with selection
Click Layer Mask icon = Layer mask equals
that of selection

Option/Alt + click Layer Mask icon = Layer
mask is inverse of selection

Shift + click layer mask thumbnail
Turns the mask on and off for a quick
preview of the layer with or without
the mask.

Levels or Curves on layer masks
Use Levels or Curves to easily modify the
opacity of the mask. Simply click the mask
thumbnail, and then use Levels or Curves to
get the effect you want.
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Option/Alt + Any Adjust submenu
command or Color Range
Holding down the Option/Alt key while
selecting any of the Adjust submenu com-
mands will load the previously used settings.
This technique also works with the Color
Range command.

This means that to load the last settings into
a dialog box, you can press Command/Ctrl
+ Option/Alt + M for Curves, Command/
Ctrl + Option/Alt + L for Levels, and
Command/Ctrl + Option/Alt + U for Hue/
Saturation.

Levels
On the Macintosh, you can use Threshold
mode with Levels to preview changes and to
locate the highlight and shadow in an image.
Deselect the Preview option and then hold
down the Option/Alt key while dragging the
input highlight or shadow sliders. A high-
contrast preview appears indicating the
highlight or shadow values that will be
clipped if the sliders are adjusted. Note that
this technique does not work on CMYK
images.

tips for adjusting color miscellaneous tips
Guides
Double-click guides to bring up preferences
for Guides and Grid

Option key while dragging toggles between
horizontal and vertical guides

Shift key snaps guides to pixel increments

Double-click rulers to bring up preferences
for Units and Rulers

Large data
You can move a layer beyond the borders of
an image and recover it after saving the
image. To eliminate elements outside of the
image area, Select All and Crop.

Paste Into
Copy something into the Clipboard. Make a
selection of a part of an image, and then
select Edit > Paste Into. The Clipboard
contents are pasted into the selected area,
and the selected area now works as a mask.

Repeat the same procedure holding down
Option/Alt as you choose Paste Into. This
time the image is pasted behind the current
selection. Remember that Paste Into is
dimmed unless you have an active selection.

Copying image sizes into new windows
You can load the image size of any open
image into the New File dialog box. After
choosing File > New, choose Window from
the menu bar. Choose any open image from
the bottom of the Window menu to copy the
image’s characteristics into the New File
dialog box.

Filling selections and layers
Shift + Delete/Backspace = Brings up the Fill
dialog box

Option/Alt + Delete/Backspace = Fills with
the foreground color

Curves
To display a tighter grid in the Curves dialog
box, Option/Alt-click inside the grid.

Option-drag input slider for high-contrast preview
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Shortcuts
/: Turns Preserve Transparency on and off for
the active layer

Option + click Quick Mask mode icon to
inverse the mask

[: Sets brush size to
next smaller size

]: Sets brush size to
next larger size

Shift + [: Sets brush
size to first brush

Shift + [: Sets brush
size to last brush

<Return>: Activates the current tool’s options
palette. If the palette is active, highlights the
first text box.

<Enter> + Active path: If a painting tool is
active, strokes the path with that tool. Other-
wise, closes the path (if open), and converts it
to a selection.

Command/Ctrl + Delete/Backspace = Fills
with the background color

Delete/Backspace = Fills a selection on the
background layer with the background color

Option/Alt + Shift + Delete = Preserves
transparency and fills with foreground color

Command/Ctrl + Shift + Delete = Preserves
transparency and fills with background
color

To choose a destination other than the
selected layer, hold down the Option/Alt key
as you choose Apply Image and then select
the destination from the Result pop-up menu.

calculations

quick keys

Press ] to select next brush

Option/Alt + Image > Apply Image

The Calculate feature in Adobe Photoshop
2.5 has been replaced by two features:
Calculations and Apply Image. Calculations
works on single channels only, and Apply
Image works on composite channels. You
can use layers to do everything these features
do except add and subtract composite image
channels. However, using these features can
save you both time and RAM.

Calculations
This feature lets you combine non-compos-
ite channels of an image or images using the
blending modes in the Layers palette (plus
Add and Subtract) and place the results into
another non-composite channel.

On the Macintosh, you can call up a smaller
version of the Calculations dialog box by
holding down the Option key while choos-
ing the Calculations command.

Apply Image
This feature lets you combine composite
images using the blending modes in the
Layers palette (plus Add and Subtract) and
place the results in the selected document
layer (the target) or in another destination.
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V: Move

W: Magic wand

B: Paintbrush

Y: Pencil

U: Smudge

O*: Dodge/Burn/Sponge

T*: Type/Type Mask

G: Gradient

I: Eyedropper

Z: Zoom

* Press again to select next tool or
mode within group

 Marquee: M*/Cropping: C

Lasso/ Polygon Lasso: L*

Airbrush: A

Eraser: E

Rubber stamp: S

Blur/Sharpen: R*

Pen/Path selection tools: P*

Line: N

Paint bucket: K

Hand: H

Swaps foreground and background colors: X

Resets foreground and background colors: D

Enters/exits Quick Mask mode: Q

Cycles through all full-screen mode options: F
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